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I. Introduction 
Shasta CELLSTUDIO Software is the main application software for instrument controls, including cell/reagent 
dispensing and cell imaging. While basic operations are covered in the Shasta Single Cell User Manual, this 
manual covers features of interest to advanced users, especially those wanting to synthesize their own 
experiments using the power and flexibility of the Shasta Single Cell System. 

The sections of this document can be applied for the purposes summarized in Table 1, provided to help you 
navigate this document more easily based on your goals. 

Table 1. Guide to using this manual for your experimental goals. 

User manual section Tool Purpose 
Sections II & III App Manager Defining a custom application workflow (dispense and 

imaging steps) in CELLSTUDIO software. 

Section IV Barcode Manager Creation and management of the barcode options 
available when setting up an experiment. 

Section V Visualizer Tool to help you with decisions involving dispense 
patterns and volumes. 

Section VI Microscope user utility Tool to help you determine the ideal imaging step 
configuration when creating your custom application, 
especially when using novel stains or sample types. 

 
Appendix A  

-- Points to consider when beginning to design a custom 
application or scaling up from a plate-based experiment 
to a low input, high-throughput automated protocol. 
The advice in this section is provided by the Takara Bio 
scientists who have first-hand experience designing our 
prevalidated Shasta applications. 

II. App Manager: Available Actions 
The prevalidated applications defined by Takara Bio—Shasta whole-genome amplification (WGA), total RNA-
seq, and mRNA-seq—are configured within CELLSTUDIO software by default. 

The app manager (application manager) is a tool in CELLSTUDIO software that allows for the creation, 
modification, and management of application workflows for use with the Shasta Single Cell System.  By using the 
app manager, additional workflow options become available for selection and use on the main CELLSTUDIO 
software interface.  

The application manager can be accessed from within the CELLSTUDIO software under the Options menu 
(hamburger  icon) in the title bar and selecting the App Manager menu option. 

http://www.takarabio.com/
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Figure 1. How to bring up the app manager. 

This will bring up the App manager view. 

 

  
Figure 2. App manager view. 

The sections below describe the functions available in the app manager and correspond to the letters labeling 
areas of the App manager view in Figure 3. 
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Figure 3. App manager elements. For more information about the labeled options, see Sections A–I below. 

A. Create a New Application 
Clicking the [New] icon will bring up the App details page (Section III.A). 
Refer to Section III for details about using the App details page to configure the parameters of the 
application. 

B. Duplicate an Existing Application 
The [Duplicate] button can be used to create a copy of an existing application. This can be useful when 
synthesizing a new workflow. For example, when doing optimization experiments, you can easily recreate 
a previously defined application to modify it without affecting the original one. 

To duplicate an application: 

1. Click on the name of the application you want to copy. In the example in Figure 4 (below), the 'Total 
RNA-seq' application was selected. 

2. Click the [Duplicate] button on the right-sidebar menu. 
The duplicated application is added to the end of the list with "(Copy)" appended to the name. The name 
can be changed (customized) by editing the application. Refer to Section II.C, the next section, for how to 
edit the application. 

http://www.takarabio.com/
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Figure 4. Example of duplicating an application in App Manager. The application highlighted in gray (Total RNA-seq) 
was the application duplicated; the blue arrow indicates the newly created duplicate application [Total RNA-seq (Copy)]. 

C. Edit an Existing Application 
The application edit function can be used to modify an existing custom application. Select a custom 
application, then click the [Edit] icon to bring up the App details page with the current configuration 
options for the application. 
Changes can then be made to the configuration, such as editing the experiment details, adding or 
removing steps, etc. Refer to Section III for more information. 

NOTE: The prevalidated applications installed as part of CELLSTUDIO software cannot be directly 
edited. Refer to Section II.I for a method to derive a custom, editable application from one of the 
prevalidated apps. 

D. Delete a Custom Application from the App Manager 
1. Select the desired app on the list view.  
2. Click on [Delete] to delete the selected app.  
3. Confirm the deletion on the confirmation dialog. 

NOTE: The prevalidated applications installed as part of CELLSTUDIO software cannot be deleted. 

E. Export an Application 
Any application defined in CELLSTUDIO software can have its configuration exported to a JSON-
formatted file. This is useful for sharing user-defined applications or for deriving an application from a 
preexisting one, such as one of the prevalidated applications. 

To perform an export: 

1. On the list view, select the desired application to export. 
2. Click [Export] on the right menu bar to bring up the Save file dialog. 
3. Navigate in the dialog to the location where the exported app file should be saved. 
4. Provide a name for the exported file. 
5. Click [Save] to complete the export. 

http://www.takarabio.com/
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F. Import an Application 
An exported application can also be imported into the app manager. This is useful for sharing user-
defined applications or for deriving an application from a preexisting one, such as one of the prevalidated 
applications. 

To perform an import: 

1. Click [Import] on the right menu bar to bring up a File Explorer selection window. 
2. Select a previously exported application file (*.json). 

 
Figure 5. Selecting an application JSON file for import into CELLSTUDIO software. For more information about 
exporting an application, see Section II.E, above. 

3. Click [Open]. 

The app will display in the list of applications in the app manager upon a successful import (Figure 6). 

 
Figure 6. The App manager list after import of an application. A key indicator that this is a custom or imported application is 
the unlocked icon next to the application name. 

NOTE: The application name will display (Figure 6) with the assigned name at the time the application 
was exported—NOT the file name (Figure 5). To modify the name displayed in the list, edit the newly 
imported app (Section II.C and change the "Name" field to be how you want the application to display in 
the list (Figure 7 & Figure 8). 

 
Figure 7. Editing the application "Name" field. 

 
Figure 8. The App manager list after application "Name" editing. 

http://www.takarabio.com/
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G. Search the Applications 
If you have a long list of applications and you want to find one or a group of applications with basic 
keyword matching, you can use the search input box to filter the list. 

To begin a search, click on the box and begin typing. The search is case-insensitive and will do partial 
matching on any part of the application name. Figure 9 shows an example of searching the list for the 
phrase 'rna'; the two results, 'mRNA-seq' and 'Total RNA-seq', demonstrate the pattern matching does not 
require that the search phrase start at the beginning of the name, nor does it need to match the case (lower 
or upper case) of the phrase. 

 
Figure 9. Example of the search bar results in the app manager. 

H. Sort the Application List 
Each column can be sorted in either ascending or descending order.  To do so, click on the text of the 
column headers. 

 
Figure 10. Pointing to the text of a column header in the App manager application list. Moving the mouse cursor over the 
text and clicking will cause the selected column to sort based on the given value. 

The initial click will sort the column in ascending order (Figure 11). An arrow pointing up (highlighted 
by the blue box) shows that the order is ascending. 

 
Figure 11. Application list sorting, ascending order. The arrow (outlined in blue) indicates ascending order. 

http://www.takarabio.com/
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A second click will toggle to descending order (Figure 12), with the arrow pointing down. 

 
Figure 12. Application list sorting, descending order. 

Re-sorting on a given column or a different column can be repeated as often desired. 

NOTE: Sorting can also be applied to a filtered subset of applications returned by the search function 
(Section II.G) 

I. Prevalidated Applications 
The apps developed by Takara Bio are denoted by a lock icon next to the app name, highlighted by the 
blue box in Figure 13. 

 
Figure 13. The lock icon next to the name of the Takara Bio prevalidated applications. 

Unlike custom applications, denoted by an unlocked icon, prevalidated apps cannot be modified or 
deleted. However, prevalidated applications can be used as a starting point to derive a new custom app, by 
the following steps: 

1. Duplicate the application (Section II.B). 
2. Edit the newly imported application (Section II.C). 

J. Exit App Manager 
To exit the app manager, either click on the home  icon or select another option from the hamburger 

  menu. 
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III. App Manager: Creating or Editing a Custom Application 
This section specifically covers creating an application within the CELLSTUDIO software app manager. Refer to 
Appendix A, "Designing an Application" for more guidance on designing an experiment that will use the 
application. 

Basic application definition overview 

• Fill out the experiment information fields (Section III.A.1) 

• Add or edit a desired workflow step 
o Add a workflow step (Section III.C) 
o Configure the step options (Section III.B) 
o Edit an existing step (Section III.H) 
o Change the order of the steps (Section III.E) 
o Remove a step (Section III.D) 
o Undo changes (Section III.G) 

• Save the application configuration (Section III.E) 
• Exit from App details (Section III.I) 

A. App Details view 
Most of the available actions in this section take place in the App details view page. A brief description of 
the parts of the view can be found below. 

 
Figure 14. The full App details view. 
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1. Experiment information 
The left side of the page contains the fields for the overall experiment configuration. 

 
Figure 15. The experiment information section of the App detail page. 

With the Summary tab selected at the bottom of the section, configure the experiment information 
on the left side of the page. 
o Name—enter a succinct name to identify the new custom app you are developing. 
o Description—(optional) if desired, you can enter more detailed information or a description 

of what the application is for into the text box.  
o Well volume—from the drop-down menu, select the type of Single-Cell chip you plan to use 

for the application. Takara Bio sells compatible chips with two different nanowell volumes: 
250 nl (Cat. No. 640183, also included in Cat. No. 640193) and 350 nl (recommended, Cat. 
No. 640019). 

2. Step information 
The right side of the page contains the fields for defining each dispense step of the experiment. 
More details about this section and the options can be found in Section III.B, "Details: Workflow 
Step". 

3. Right-navigation menu bar 
This menu contains icons for all the actions that can be enacted on the page. Each action is 
described in a section. The sections covering each action are listed below. 

• [Add] —add a new workflow step to the application (Section III.C) 

• [Remove] —delete an existing workflow step (Section III.D) 

• [Move up]  / [Move down]  —move a selected workflow step up or down the order 
(Section III.E) 

http://www.takarabio.com/
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• [Save] —save edits made to the application configuration (Section III.F) 
• [Cancel] —undo any edits made to the application configuration since the last save 

(Section III.G) 

• [Exit] —exit the App details view (Section III.I) 

B. Details: Workflow Step 
NOTE: The following instructions are all required unless noted otherwise. 

 
Figure 16. The workflow step information view of the App details page. 

With "Step Details" selected at the bottom of the section, define the step information. 

NOTE: As certain fields are filled in, the information will also be updated and display in the experiment 
details section of the page, in the space under the "Well volume" option. 

http://www.takarabio.com/
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Figure 17. Experiment step overview in the experiment detail section of the App details page. The step name, dispense 
volume, and filter-file status are displayed. A "Filtered?" value of 'True' means the dispense will be restricted by a filter file; 
'False' means the dispense has no restriction (i.e., dispense will be to all 5,184 wells of the chip).  

1. Name 
A brief name that describes the step, such as 'Cell' for a cell dispense step or a reagent name for a 
reagent dispense step, such as 'PCR mix'. 

2. Step Type 
The step type will be predefined by the choice made when the step is added (Section III.C), but it 
can also be configured from the drop-down list. 

 
Figure 18. The step information section of the App details page. 

• Sample—sample dispense 
• Reagent—reagent dispense 
• Index—index dispense 
• Imaging—scanning the chip for candidates 

3. Cell, Reagent, and Index Step Configuration Options 

a) Use Filter File 
(Optional) Check this box if the step should require use of a filter file for the dispense. 
For more information about filter files, see the Shasta Single Cell User Manual and the 
Shasta CellSelect Software User Manual. 

NOTE: It is unusual for sample dispenses to use a filter file, but there is no restriction on 
doing so. 

http://www.takarabio.com/
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b) Pause Before Aspiration 
(Optional) Check this box if you want the system to pause during a dispense cycle and 
prompt the user to mix samples/reagents or refill the 384-Well Source Plate between 
aspirations. 

c) Volume (nl) 
Select the desired dispense volume from the drop-down list. Options range from 35–100 
nl in 5 nl increments. 

NOTE: Takara Bio has validated 35 nl, 50 nl, and 100 nl for general use. For any other 
volume choice, we recommend performing validation experiments. Refer to Appendix A, 
"Designing an Application", for more information about designing a non-standard 
application. 

 
Figure 19. The "Volume (nl)" drop-down menu, expanded. The dispense volumes validated by Takara 
Bio (35, 50, and 100 nl) are highlighted by blue boxes. 

d) Source Plate Layout  
Select the desired 384-Well Source Plate layout pattern from the drop-down list.  The 
drop-down feature will not be active until a "Step Type" is chosen (Section III.B.1, 
above); the selected step type will define the available options in the drop-down menu. 
For all selected layout types other than 'None', a preview of the plate layout will display 
under the option. 

The layout options for each dispense type and an example of their correlated source plate 
maps are listed below. 

• Sample dispense 
o Cells and controls—this layout will include eight wells that should be filled with 

your sample(s) and two wells (one each) for your positive and negative controls. 
o Cells—this layout will only include the eight wells designated for your 

experimental sample. 
o Cells and buffers—this layout is intended for situations where specific samples 

or reagents need to be dispensed into designated wells using a filter file, while 
the remaining wells are filled with buffer or other reagents.  
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Figure 20. "Source Plate Layout" drop-down options for cell dispenses. 

 
Figure 21. Source plate layout preview display. The 'Cells and controls' option of a sample dispense 
step is shown. 

• Reagent dispense 
Reagent 1–6—Up to six different reagents can be configured to dispense; each 
selection from the drop-down menu represents a different source plate layout 
(Figure 23). Other than where the source wells for the reagents, there is no difference 
in these selections. 

 
Figure 22. "Source Plate Layout" drop-down options for reagent dispenses. 
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Figure 23. Source plate layout map, Reagents 1–6. This image is shown as a composite of the six layouts; when selecting one from the menu, only 
the associated eight wells will be highlighted. 

• Index dispense 
Index1, Index2—Up to two index dispenses can be performed per application; the 
source plate layouts for each correlate to the forward and reverse indexes of the 
Shasta Long Indexing Primer Set - A (Cat. No. 640283) and the SMART-Seq® Pro 
Indexing Primer sets (Cat. No. 640258 & 640260) from Takara Bio. 

 
Figure 24. "Source Plate Layout" drop-down options for index dispenses. 
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Figure 25. Source plate layout map, Index 1 & Index 2. This image is shown as a composite of the two layouts: pink (columns 5–10) indicates the 
source wells for Index1, teal (columns 13–18) indicates the source wells for Index2. 

4. Imaging Step Configuration Option 
If the step type selected is 'Imaging', the configuration options specific to cell, reagent, or index 
dispenses (Section III.B.3, above) are grayed out (i.e., cannot be modified). Instead, an [Add New 
Filter] section will display. 
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Figure 26. Add New Filter configuration option shown when the Imaging step type is selected. 

This feature allows you to set up default parameters for your application relating to the three color 
channels available for imaging (red, blue, and green). 

NOTE: Although this sets up the default imaging filter settings for your application, you can also 
modify the settings on an experiment-by-experiment basis in the chip scan step when running the 
custom workflow. Refer to the Shasta Single Cell System User Manual, Appendix B, for more 
details. 

a) How to Add an Imaging Filter to the Imaging Step 
1. Click [Add New Filter] to begin. This will set up an initial row in the table. 

 
Figure 27. The configurable options of an imaging filter. 
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2. Configure the parameters of the color channel you wish to scan for. There are three 
values that can be set and one action that can be taken in this view: 
• Channels—selected by a drop-down menu, this is the color for which you want to 

scan. 

 
Figure 28. Drop-down menu options for the imaging filter "Channels" column. 

Table 2. Excitation and emission information for the available color channels*. 

Color 
channel 

Excitation λ (nm) Emission λ (nm) 
Center Width Center Width 

Blue 377 50 447 60 
Green 485 20 536 40 
Red 544 24 641 75 

*The values are the default hardware configuration; the hardware can be modified if 
desired. Contact your authorized Takara Bio service technician or 
field_support@takarabio.com for more information. 

• Exposure(ms)— the length of time in milliseconds the camera sensor spends 
capturing the image for each well. The exposure time for a given color channel 
should be in the range of 2–500 ms, although values up to 2,000 ms are possible. 

To set or edit the value, click on the cell to activate the input box (Figure 29, left) 
and type in the numerical value desired. Press [Enter] on your keyboard to 
commit the value to the configuration (Figure 29, right). 

  
Figure 29. The imaging filter "Exposure(ms)" input box. (Left) The input box is shown (white 
background) after the cell in the column is clicked on, and a number can be typed into the field. 
(Right) The cell after committing the change. 
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• Gain—represents the amount of amplification applied to the signal coming from 
the camera sensor, i.e., the camera sensitivity. 
Select a value from the drop-down menu of either '5', '10', or '15'.  We 
recommend that you start with a gain of 10 when setting up a new filter. 

 
Figure 30. The imaging filter "Gain" drop-down menu. 

• Action—clicking the  icon in this column will delete the row and its 
configuration information. 

IMPORTANT: There is no confirmation prompt and no method to undo the 
deletion. Please use it wisely. 

3. Repeat Step 1 and Step 2 for any additional color channels you want to add to the 
imaging filter, up to the maximum of three. 

Figure 31 shows an example of a two-color imaging filter set up for the red and blue 
channels. 

 
Figure 31. Example imaging filter configuration display. 
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b) Recommendations for the Imaging Filter Settings 
When setting these values, keep the following in mind: 

• Be sure that the "ID" selections reflect the candidate logic you wish to use in 
CellSelect software for experiments using your application. At least one dye color is 
required to identify the presence of cells in the nanowell; a second or third color may 
be used for further refinement to determine well candidacy. Refer to the Shasta 
CellSelect Software User Manual, Section II.C "Candidate Logic Selection" for more 
information. 

• In general, you want to adjust the "Exposure" time and "Gain" so that all cells are 
clearly visible above the background, i.e., a high signal-to-noise ratio—but be careful 
to not overexpose the image. 
o Higher gain values produce brighter, but also noisier, images. 
o If the exposure time is too high, brighter pixels on the camera may become more 

visible. Also, longer exposure times also mean longer scan times. 
For more assistance in determining the ideal settings for your novel stains or cell types, 
use the Microscope Utility. For more information about this feature, refer to Section VI. 

5. Offline Instructions PDF File 
(Optional) Associate an offline instructions file to display in the software after the step is 
completed. For more information about creating a custom instruction file, see Appendix B. 

NOTE: For an example of how this is implemented in the workflow, refer to the Shasta Single 
Cell System User Manual, Section IX.E, "Start Dispense" in the note associated with Figure 59. 

At the bottom of the page, select the Step instruction tab. 

 
Figure 32. The Step instruction tab in the step details section of the App details page. 

This will bring up the Step instruction page. 

 
Figure 33. The Step instruction page. 
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a) Adding a New Instruction File or Replacing an Existing Instruction 
1. Click on the [Select a PDF file] icon  to the left of the box to bring up a File 

Explorer file selection window. By default, it will open in the "Documents" folder. 
2. Navigate to the folder containing the instruction PDF file you want to associate with 

the step. 

 
Figure 34. Selecting an instruction PDF file. 

3. Select the PDF and click [Open]. The path where the instruction file is located will 
display in the "Instruction PDF file" input box, and the contents of the file will 
preview on the page. 

 
Figure 35. The Step instruction page after selecting a PDF. 
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b) Replace a Previously Defined Offline Instructions PDF 
To replace an existing file, repeat Section III.B.5.a). 

c) Removing the Association with an Offline Instruction File 
To remove an instruction PDF file without replacing it, click on the [Remove]  icon to 
the right of the file name. 

Once the changes have been made, it is safe to navigate away from this page without further 
action. 

C. Action: Add (a Workflow Step) 
1. On the right-navigation menu bar, click [Add] to define a new workflow step. 
2. A pop-up box will display, prompting you to choose the step-type to add (Figure 36). Click on the 

desired option from the list. 

 
Figure 36. Selecting a step from the experiment detail section of the App details page. 

3. The right-side section of the App details page (step information) will activate, as shown in Figure 16 
(Section III.B, above). 

Refer to Section III.B, "Details: Workflow Step" for more information about the option types. 
NOTE: If the option selected is 'Sample', the add function will also automatically create an 'Imaging' step 
named "Scan chip", shown in Figure 37, below. It should be configured like an existing step 
(Section III.H) or deleted (Section III.D) if an imaging step is not required for the workflow. 
It will not be automatically deleted if the related sample step is deleted; it should be deleted manually. 

 
Figure 37. The automatically added "Scan chip" imaging step. This is added at the same time a 'Sample' workflow step is 
added to an application and should be configured if imaging is desired for the workflow. 
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D. Action: Remove (a Workflow Step) 
1. On the list of steps in the experiment detail section, select the desired step that you want to remove. 

The selected step will have a gray background. 

 
Figure 38. Selecting a step from the experiment detail section of the App details page. 

2. From the right-navigation menu, click [Remove] to delete the step. 

NOTE: There is no confirmation prompt for this deletion to take effect. 

E. Action: Re-order the Steps in the Workflow 
By default, workflow steps are listed in the experimental detail section in the order in which they are 
added. 

The [Move up] and [Move down] arrows can be used to re-order the steps within the workflow. 

1. Select the step from the workflow list that you would like to move (similar to Figure 38, above). 

2. Click the [Move up]  button to shift the step to be earlier in the workflow. 

 
Figure 39. Moving a workflow step up in the list on the App details page. The image shows the step selected in Figure 38 
moved up one step from the third to the second step in the workflow. 

3. Click the [Move down]  button to shift a step to occur later in the workflow. 

 
Figure 40. Moving a workflow step down in the list on the App details page. The first step in Figure 39 was moved down 
one step to become the second step. This has the effect of moving the second step up to be the first step. 
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F. Action: Save (Changes) 
After any field is populated with a value in the experiment detail section of the App details page, the 
[Save] icon on the right-side menu can be clicked to save the configuration to-date. 
It is recommended, but not necessary, for the experiment "Name" field to be filled in, to more easily 
identify it in the list of applications in the app manager. 

G. Action: Cancel (Undo Changes) 
The [Cancel] button can be used to undo all edits made to an application's configuration in the App details 
view since the last time it was saved (Section III.E). 

NOTE: There is no confirmation prompt for this rollback to take effect. 

H. Action: Edit an Existing Workflow Step 
On the list of workflow steps in the experiment detail section, select the desired step that you want to 
change. The selected step will have a gray background (Figure 38). 

The configured options for the step can then be modified. Refer to Section III.B ("Details: Workflow 
Step") above for the information that can be changed. 

I. Action: Exit (App Details) 
At any point, you can click the [Exit] icon to leave the App details view and return to the App manager 
page. 

If any changes have been made to the application configuration while in App details, you will be 
reminded to save before exiting. Click [No] to return to the App details view to save (Section III.E, 
above) or [Yes] to exit without saving the changes (Figure 41, next page). 

 
Figure 41. Confirmation dialog when attempting to exit the App details page. The prompt will only pop up if edits were made 
to the application configuration and were not saved. 
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IV. Barcode Manager 
The barcode manager functionality can be accessed via drop-down from the Options menu (hamburger  icon) 
(Figure 42) in the top right corner of CELLSTUDIO software.  

 
Figure 42. How to bring up the barcode manager. 

This will bring up the Barcode manager view. The sections below describe the functions available in the barcode 
manager and correspond to the letters labeling areas of the Barcode manager view in Figure 43. 

 
Figure 43. Barcode manager elements. For more information about the labeled options, see Sections A–G below. 
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A. Installed Barcodes 
The list in the box on the left of the screen displays the list of the barcodes currently installed on the 
system.  

 
Figure 44. Example list of installed barcodes. The barcodes for index sets sold by Takara Bio have a lock icon next to their 
name (enclosed in the red box) and come preinstalled with the software. 

CELLSTUDIO software comes preinstalled with the barcode information for index sets sold by Takara 
Bio for use with the Shasta system (Table 3); these sets are denoted by the lock icon next to their name 
(highlighted by the red box in Figure 44). Custom barcode files will be listed with the name given to the 
file set during barcode definition (Section IV.C) or if renamed (Section IV.D); they are indicated as 
custom by the unlocked  icon next to the name. 

Table 3. Preinstalled barcode file association with Takara Bio index sets. 

CELLSTUDIO 
barcode name Product name Cat. No. 
Short SetA SMART-Seq Pro Indexing Primer Set - A 640258 
Short SetB SMART-Seq Pro Indexing Primer Set - B 640260 
Long SetA Shasta Long Indexing Primer Set - A 640283 
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B. Barcode Details 
Selecting one of the installed barcodes (Figure 44) will display information about the index set in the 
Selected Barcode Details view on the page (Figure 45). 

 
Figure 45. Example Selected Barcode Details view of the Short SetA option. The display is shown truncated in the screenshot in order to include 
both the headers and navigation button footer, outlined by the red box. 

By default, the table will span 5,184 rows across 173 pages—one row for every well on the Single-Cell 
chip. Page navigation can be performed in one of three ways, using the buttons in the footer of the view: 

• Click the single forward  or backward  arrow to go one page forward or one page back, 
respectively. 

• Click a number from the bar to jump to that numbered page (i.e., Page 5). 

• Click the "go to the end" button  to jump to the last page of the table (page 173). Similarly, click 

the "go to the beginning" button  to jump to the first page from anywhere in the table. 

The column information for each row (well) is described in Table 4. 
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Table 4. Column definitions for the Selected Barcode Details table. 

Column 
header Definition 
Row The row location of the well on the Single-Cell chip. Rows are numbered 0–71 (72 

rows).  
Col The column location of the well on the chip. Columns are also numbered 0–71 (72 

columns). 
P7 Index (i7) The set of bases that represent the i7 barcode 
P7 Index Source 
Plate Well 

The well location on the 384-well plate where the i7 barcode is drawn for the 
dispense. 

P5 Index (i5) The set of bases that represent the i5 barcode 
P5 Index Source 
Plate Well 

The well location on the 384-well plate where the i5 barcode is drawn from for the 
dispense. 

C. Define a New Barcode Set 
To create a new set of barcodes, select the [New]  icon, which will take you to the Barcode creation 
view. 

 
Figure 46. Barcode creation view. 

The parts of the interface identified by the numbered callouts—and the list of steps to define the new 
barcode option—are listed below: 

1. Download the i5 and i7 index template files from the buttons on the right. It is recommended to use 
the template file as the basis for populating your index CSV files to ensure the correct format is 
followed. 
Once both CSV files are set up with your indexes of choice, save them somewhere where they can be 
located by CELLSTUDIO software (locally or on a network drive). 

2. Name—give a unique name for the new barcode you are creating. Special characters are allowed. 
3. i5 Index Set CSV file—select the CSV file you created for the i5 barcodes in Step 1 by clicking the 

[Click here to select the csv file] button. 
4. i7 Index Set CSV file—select the CSV file you created for i7 barcodes in Step 1 by clicking the 

[Click here to select the csv file] button.  
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5. Save  —once Steps 2–4 are completed, the save icon will darken  to indicate it is active to 
select. Click it to save the new barcode options.  

6. Cancel  —at any time, click the cancel button to quit out of the view and return to Barcode 
manager view. 

D. Rename a Barcode Set 

NOTE: Predefined barcode sets cannot be renamed. 
Custom barcode sets can be renamed directly from the Barcode manager view. 

1. From the list of installed barcodes (Figure 44), select the barcode set you want to rename. 

2. Click the [Rename]  icon. This will bring up the Renaming dialog. 

 
Figure 47. Renaming pop-up dialog. 

3. Enter the new name in the box.   
4. Click [OK] to apply the new name to the set or [Cancel] to exit the dialog with no changes. 

E. Delete a Custom Barcode Set 

NOTE: Predefined barcode sets cannot be deleted. 
To delete a custom barcode set: 

1. From the list of installed barcodes (Figure 44), select the custom barcode set you want to delete. 

2. Click the [Delete]  icon. A confirmation window will pop up. 

 
Figure 48. Confirmation pop-up dialog to delete a custom barcode set. 

3. Click [Yes] to delete the set or [No] to exit the dialog with no change. 
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F. Export Barcode Set 
Any barcode set in CELLSTUDIO software can be exported as an XML file, which can be useful for 
reanalyzing a scan output with CellSelect software specifying a custom barcode set. 
1. From the list of installed barcodes (Figure 44), select the custom barcode set you want to delete. 
2. Click the [Export]  icon. A Save As dialog window will pop up. 

 
Figure 49. Save As window pop-up when exporting a barcode set. 

3. Navigate within the window to the directory where you want to save the file. 
4. Type the name with which to save the file as in the "File name" field. 
5. Click [Save] to complete the export or [Cancel] to quit with no change. 

G. Barcode Search 
If you have a long list of barcode sets and you want to find one or a group of sets using name pattern 
matching, you can use the search input box to filter on the list. 

To begin a search, click on the box and begin typing. The search is case-insensitive and will do partial 
matching on any part of the application name. Figure 50 shows an example of searching the list for the 
phrase 'ORT; the two results, 'Short SetA' and 'Short SetB', demonstrate the pattern matching does not 
require that the search phrase start at the beginning of the name, nor does it need to match the case (lower 
or upper case) of the phrase. 

 
Figure 50. Example of the search bar results in the barcode manager. 
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H. Exit Barcode Manager 
To exit the Barcode manager, either click on the home  icon or select another option from the 
hamburger   menu. 

V. Visualizer  
The visualizer tool can be accessed through the Options menu (hamburger  icon) by selecting Visualizer. 

 
Figure 51. How to bring up the visualizer tool. 

This will bring up the Visualizer view (Figure 52). The sections below describe the functions available in the tool. 

 
Figure 52. The Visualizer page. 
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How to Use the Visualizer 

1. Select the app you are interested in visualizing.   

2. Select a step of the selected app to visualize. 

3. Use the available tabs on the left panel to visualize information about the aspirations and dispenses.  

a. Use the options and filters on the right panel on the Chip Map tab to refine what data is displayed. You 
can select specific tips, aspiration numbers, and drop indexes.   

b. Query Specific Wells: Enter the row and column of a specific well to get detailed information about it in 
the "Query Well details" section. 

A. Dispense Type Selection 
The fields at the top of the visualizer (everything above the box) allow you to select the dispense type you 
want to obtain more in-depth information for. The parameters available display based on whether the 
"Use apps?" box is checked or unchecked. Sections 1 and 2 cover these two options. 

1. With "Use Apps?" Checked 
When the "Use Apps?" button is selected, the top bar offers view selections based on the 
applications defined within CELLSTUDIO software, both predefined and custom workflows. 

 
Figure 53. The top bar of the Visualizer page, using apps. 

• Apps—select a defined application from the dropdown menu.  

 
Figure 54. Example "Apps" dropdown menu on the Visualizer page. 
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• Steps—once an app is selected, an individual step of the workflow can be selected. This 
allows you to view detailed information on the mechanics of the dispense. 

 
Figure 55. Example "Steps" dropdown menu on the Visualizer page. The workflow steps of the prevalidated 
Shasta WGA application is shown here. 

• Filter file—(optional) if the step selected is for a reagent or index, this third option will be 
available. Selecting a filter file (CSV), such as one used for a dispense, will restrict the 
information details by the effects of the filter file. For sample dispense steps or leaving this 
blank, the information displayed will assume dispense to all wells on the Single-Cell chip. 

2. With "Use Apps?" Unchecked 

NOTE: This option is only recommended if you want to explore different dispense volumes prior 
to building a new application (i.e., design mode). You must configure the parameters under the 
Options tab (Section V.B.5) to make use of the unchecked "Use Apps?" option. 

When the "Use Apps?" button is not selected, the main option of the top bar is based on the 
source plate layouts available when defining a custom application. 

 
Figure 56. The top bar of the Visualizer page, "use apps?" is unchecked. 
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• Layout ID—select one of the source plate layouts from the dropdown menu. The scrollbar on 
the right of the list can be used to access layouts not displayed in the first seven options. For 
more information on the layouts, refer to Section III.B.3.d, "Source Plate Layout".  

 
Figure 57. Example "Apps" dropdown menu on the Visualizer page. 

• Filter file—(optional) if the step selected is for a reagent or index and you want to see what 
the dispense would be like for the layout selected based on a filter file, select the file here. 
This will restrict the information details displayed by the parameters defined by the filter file. 
For sample dispense steps or leaving this blank, the information displayed will assume 
dispense to all wells on the Single-Cell chip. 

B. Dispense Details 
Once the parameters for the dispense type you want to view are selected (Section A), detailed information 
about the dispense will display in the box on the main part of the visualizer page. The information 
displayed is based on the menu on the left side of the box. 

Click on any of the tab names to view the information on that tab page. A brief overview of each tab 
option is listed below; see their corresponding sections for more details. 
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Figure 58. The tab options in the visualizer dispense details section. 

1. Details—provides the overall detailed information about the required aspiration and dispense 
information 

2. Plate Map—displays the layout of samples on a 384-Well Source Plate 

3. Chip Map—displays the chip map visualization 

4. Tips Usage—displays how the tips are used to dispense in a selected step 

5. Options—the settings available to configure for visualization purposes 

NOTE: The 'DNA Extraction' step of the Shasta WGA application is used as an example to illustrate the 
concepts below. 

1. Details Tab 

 
Figure 59. The visualizer Details tab contents. 

Two tables are displayed on the Details tab: 

• Aspiration Details 
This table summarizes the necessary aspirations from a 384-well plate to perform the 
complete dispense step into the chip. Each row represents a cycle of aspirating from a source 
plate—i.e., when the syringes load the sample, reagent, or index; the totality of cycles equals 
the dispense. 
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Each row details for the specified cycle: 
o The volume (per tip) aspirated for each cycle  
o The loading position of the tip nozzle assembly (the XYZ location in space according to 

the control software) 
o The number of tips employed (1–7, or 'All' when all eight tips are utilized) 
This information can be used to calculate the loading volumes for each well of the 384-Well 
Source Plate but requires that the Options parameters (Section V.B.5) be set; refer to that 
section, if necessary. 

• Dispense Details 
This table provides a summary of the dispenses into the chip corresponding to each cycle of 
aspirations from the source plate. It outlines: 
o Volume of solution dispensed per chip well 
o Number of wells that will be dispensed to (total value, from all tips employed) 
o Number of movements by the tip nozzle assembly necessary to cover the number of wells 

(previous column) 

2. Plate Map Tab 

 
Figure 60. The visualizer Plate Map tab contents. 

This tab displays the 384-well source plate layout map representing the selected dispense step, 
shading the wells where the reagents should be aliquoted. 

• The "Zoom" slider in the top-right corner can be used to enlarge or shrink how the map is 
displayed on the screen. 
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NOTE: There is no functionality to move the view of the plate map around while zoomed in, 
which could roll wells off the screen. 

• The [Export data] button can be used to export the data of the layout map to a TSV file. 

3. Chip Map Tab 
This tab displays a heat map of the Single-Cell chip and represents dispense data for each well. 
The color gradient indicates the values of the selected parameters under "Options" and "Filters". 

The heatmap is shown rotated 90° counterclockwise from the orientation of the chip in the chip 
nest, with the chamfered corner on the upper right (heatmap) rather than the lower right (chip 
nest). Refer to Figure 61 for a comparative view. 

 
Figure 61. The visualizer Chip Map tab, aggregate view, with chip comparison. By default, the boxes on the right-side of the image are part of a 
scroll-bar menu and not fully displayed. The inset image illustrates the orientation of the heatmap as compared to the actual chip, which is rotated 90° 
counterclockwise from the orientation in the chip nest. 
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This tab displays a heat map of the Single-Cell chip and represents dispense data for each well. 
The color gradient indicates the values of the selected parameters under "Options" and "Filters". 

The sections below provide more information about each of the right-side menu elements. 

a) Zoom 
Use the slider to zoom in and out of the displayed chip heat map. 

b) Options 

 
Figure 62. The Options dropdown menu in the visualizer Chip Map tab. 

Use the "Type" dropdown menu to select the type of heat map data to be displayed as a 
relationship of the selection and the chip wells shown. By default, "DropIndex" is 
currently selected.   

• SourceWell—relationship with the 384-Well Source Plate wells. 

• Tips—relationship with which tips were employed to dispense. 

• DropIndex—relationship with the movements of the tip nozzle assembly for each 
aspirate-dispense to the chip. The value starts with '1' at the beginning of each cycle. 

• GlobalDropIndex—the relationship with the movements of the tip nozzle assembly 
for the entire dispense (aggregation of the DropIndex data); i.e., this value will 
increment for every time the assembly moves and is not reset when a new cycle 
commences. 
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• DropGroup—the relationship with the aspirate/dispense cycle, i.e., which cycle the 
dispense occurs. The wells will be color coded depending on which cycle it is 
dispensed in. 

• WellNum—the sequential well numbering of the chip wells.  

c) Filters 
The filter parameters can be used in conjunction with the options to view only the portion 
of the data on the chip heat map. 

• Tip 1–8—the checkboxes enable or disable the display of data from a specific tip 
nozzles.  Figure 63 shows a view of the tip nozzle assembly as seen from the open 
door of the Shasta instrument with two of the tips in the foreground labeled (Tip 2 
and Tip 8). Table 5 shows a map of the tip nozzle assembly if viewed from the top 
down, with the tip numbers identified by their position within the assembly. 
Figure 64 shows an example heatmap when filtering by tip number. 

 
Figure 63. Tip numbering identification visual guide. When looking into the Shasta instrument from 
the open door, Tips 2, 4, 6, and 8 are the ones visible (in the front, right to left) of the tip nozzle 
assembly. See Table 5 for the top-down map. 

Table 5. Tip numbering map in the tip nozzle assembly, top down-view. 

Back row 
 

    

    
 

Front row 
[DOOR] 

7 5 3 1 

8 6 4 2 
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Figure 64. Example of filtering by tip number, visualizer Chip Map tab. The chip heat map is displaying only the wells dispensed to by Tips 1–4. 

• Aspiration #—allows you to view the heat map for a specific cycle (round of 
aspiration); the cycle number correlates to the values in the Details tab tables. The 
default value, '0', is an aggregate of all cycles.  

 
Figure 65. Example of filtering by Aspiration #, visualizer Chip Map tab. The chip heat map is displaying only cycle #4. 

• Drop Idx— filters the data by specific drop indexes. This value indicates the 
movement number of the tip nozzle assembly when performing a dispense within a 
cycle. Because, as described above in Options, this index value resets at the 
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beginning of each cycle/aspiration within the dispense, specifying a "Drop Idx" value 
with no additional filters will display every well dispensed on the 10th position 
within each cycle. For a four-cycle dispense, this might be up to 32 wells (8 tips * 4 
cycles). 

Example (shown in Figure 66): 

Putting a value of '10' in this field will no other filters will display all 32 wells 
dispensed to on the 10th position of the tip nozzle assembly. 

However, if also restricted by the "Aspiration #" value of '1', it will show only the 
10th position within the first cycle and therefore only eight wells (one for each tip). 

 
Figure 66. Example of filtering by "Drop Idx", visualizer Chip Map tab. The "Drop Idx" value for both heat maps is '10' in the example. (Left) 
Drop Idx filter, with no other filters. (Right) "Drop Idx" value '10' of "Aspiration #" '1'. 

• Global Drop Idx—filter the data by a drop index aggregated across all cycles. 

Example: 

If viewing the heat map through the option 'GlobalDropIndex', it can be determined 
that the total number of drops (tip nozzle assembly movements to dispense eight 
wells per drop) is 648 (circled in Figure 67).  

The total number of drops (648) defines the upper bound of the input value range for 
the "Global Drop Idx" filter; in this case, a value from 1–648 can be selected. 
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Figure 67. Example of the 'GlobalDropIndex' option in the visualizer Chip Map tab. 

In this example, the number of drops in cycle #1 is '194'. This means that the "Global 
Drop Idx" equal to '195' is the equivalent of cycle #2, drop value '1'. 
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Figure 68. Comparison of "Global Drop Idx" versus "Drop Idx" for equivalent tip nozzle assembly positions. (Top) The 195th position in the 
overall dispense run. (Bottom) The first position of cycle #2. The heatmap illustrates that these are the same dispense. 

  

http://www.takarabio.com/


 Shasta™ Single Cell Advanced Features User Manual 

(072425) 
 

takarabio.com 
Takara Bio USA, Inc. 

Page 49 of 72 

 
 

d) Query Well Details   
This section of the menu allows you to enter a specific Row (0–71) and Column (0–71) 
location for a well (well address) on the chip. 

 
Figure 69. Row and column number identification on a Single-Cell chip. The chamfered corner of the chip is indicated to aid with visualization. 
(Left) The chip in the same orientation on the heat map. (Right) The top-down view of the chip as it is oriented in the chip nest. Note that the image 
on the left, which matches the orientation of the heat map, is rotated 90° counterclockwise from how the chip is oriented in the nest. 

After entering the row and column index values, the following information is displayed 
for the specified well: 

• Tip—the number of the tip used to dispense to it   

• Drop idx—the drop index value for the dispense; this is the numbered position of the 
tip nozzle assembly within a cycle  

• Source well—the letter and number identifier of the well on the 384-well plate that 
was the source of the aspiration dispensed to this location 

• Round—the cycle number when this well was dispensed to 

• Dispensed?—a boolean (True/False) value that indicates whether a dispense occurs 
in this well 

e) Export all data/Export heatmap data 
The two export buttons, [Export all data] and [Export heatmap data], can be used to 
translate the data populating the heatmap into one of two formats. 

• [Export all data]—repackages the data into a TSV file with seven columns of data a 
row for each of the 5,184 wells on the chip across the following seven data columns: 
o Chip row number (Figure 69) 
o Chip column number (Figure 69) 
o Dispense tip number (Figure 63 and Table 5) 
o Drop index value  (see c) Filters) 
o Global drop index value (see c) Filters) 
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o Dispense round (i.e., the cycle number) 
o Source well ID—of the 384-Well Source Plate 

 
Figure 70. Partial view of an example [Export all data] TSV file for the Chip Map view. Values 
reflect the Shasta WGA > DNA extraction dispense step. 

• [Export heatmap data]—translates the heatmap into a numerically equivalent TSV 
file of 72 columns x 72 rows, where each cell of the file is a well on the plate. The 
file is read like the heatmap, with Row 0, Col 0 in cell A1 of the file and Row 71, Col 
71 in cell BT72; the cell values correspond to the number of the well on the 384-well 
plate (1–384), where plate well A1 is '1' and plate well P1 is '16'. 

 
Figure 71. Partial view of an example [Export heatmap] TSV file for the Chip Map view. Values 
reflect the Shasta WGA > DNA extraction dispense step: '33' is the source well "A3", '34' is source well 
"B3", '49' is source well "A4", etc. 
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4. Tips Usage tab 
This tab displays heat maps that show the relationship between each tip nozzle and the drop index 
for each aspiration and dispense cycle for the selected steps. Refer to the Chip map "Options" 
(Section OptionsV.B.3.b)) for the definition of "drop index". 

Interpreting the charts 

Figure 72 shows aspirations #3 and #4 of the Shasta WGA DNA extraction dispense step. The X-
axis is the drop index—i.e., the total number of drops distributed on the chip during the cycle. As 
can be seen by the numbered ticks, aspiration #3 performed 194 drops, but aspiration #4 only 
performed around 67. 

The Y-axis is divided across all eight tip nozzles, with each horizontal bar capturing an aggregate 
of whether or not the nozzle distributed fluid for the given drop index (black, Used) or not (white, 
Not used)—see the legend to the right of each chart. 

In this instance, all eight tip nozzles are employed to dispense on every drop index, but the 
individual stripes on the chart display differently if a filter file was implemented depending on the 
distribution of candidate wells on the chip (Figure 73). 

 
Figure 72. Example of the Tips usage view in the visualizer, with no filter file applied. 

 
Figure 73. Example of a Tips usage chart in the visualizer with a filter file applied. 
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5. Options tab 
This tab displays the available configurations for the visualized data.  Modification of this is not 
generally recommended.  Please contact your authorized Takara Bio service technician or 
field_support@takarabio.com for how to properly modify this. 

 
Figure 74. Options tab example. 

VI. Microscope Utility 

A. Overview 
This option from the User Utility view allows you to visually inspect individual wells on the chip. 

The feature is intended to assist with optimizing the imaging settings needed during the cell scan step 
(Section III.B.4.b, "Recommendations for the Imaging Filter Settings"), either because of novel sample 
cell types or when using custom cell stains. 

The Microscope utility can be accessed under the Options menu (hamburger  icon) in the title bar and 
selecting the User Utilities menu option. 
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Figure 75. Accessing the User Utilities menu item. 

From the User Utilities view, click on the [Microscope] icon. 

 
Figure 76. The [Microscope] icon on the User Utilities view. 
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B. Microscope View 

 
Figure 77. The Microscope utility view. 

The parts of the view (Figure 77) numbered (1–6) correspond to the list below. 

1. Place the chip 
If the chip of interest is not already loaded into the Shasta instrument chip nest, insert it first. The 
two methods here are used to move the camera to set positions: 

• Clicking the [Park] button moves the camera to the Y and Z position of '0' and the X position 
to be centered behind the chip nest. This position has the tip nozzle assembly (which includes 
the camera) away from the chip nest area. 

• Clicking anywhere on the chip map moves the camera to the selected position on the chip.  
The chip map is color coded to display the source wells. 

 

2. Select chip type 
From the dropdown menu, select the well volume for the chip to be examined. This will either be 
'250nl' for the Single-Cell 250f Chip or '350nl' for the Single-Cell 350v Chip. Do not select the 
'150nl' option. 
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Figure 78. Microscope "Select chip type" dropdown menu. 

3. Select filter 
Filter, in this case, refers to the color channel suitable for the stains, such as blue, red, etc. White 
is also an option here. 

 
Figure 79. Microscope "Select filter" dropdown menu. 

4. Select exposure and gain 
Type in a numerical value for the exposure (in milliseconds) and select a gain value from the 
drop-down for how you would like to review your images. For more information about what 
these parameters mean, refer to Section III.B.4.a), "How to Add an Imaging Filter to the Imaging 
Step". 
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Figure 80. Microscope "Select exposure and gain" step. 

5. Select a chip pos 
'Pos' refers to the position of the chip you want to visualize. The position value refers to a specific 6 x 6 
well area of the single-cell chip assigned by CELLSTUDIO software; there are 144 total positions (Pos0–
Pos143) mapped on the chip. Select any area on the chip to travel to the desired position. 

 
Figure 81. How to map the Pos values to areas on the Single-Cell Chip. 'Pos0' is assigned to the 6 x 6 grid of wells 
starting at Row: 0/Col: 0; 'Pos143' is at Row: 71/Column: 71. The numbering increments from left to right, then starts 
at the far left on the next row. The figure reflects the orientation of the chip as it is displayed in CellSelect software and 
in the visualizer chip heatmaps (Section V.B.3). 

NOTE: As a reminder, the chip orientation shown above is rotated 90° counterclockwise from 
the orientation of the chip as it presents in the chip nest (Figure 69). 
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C. Image Viewer Tools 
The Image Viewer portion of the microscope utility offers a number of tools to assist you with evaluating 
the images. The toolbar is shown in Figure 82, with a description of each tool listed below it. 

 
Figure 82. Microscope Image Viewer toolbar. 

•  [Snap] – takes a snapshot of the current wells displayed in the Image Viewer field. 

•  [Auto contrast] – applies automatic contrast tool automatically if toggled on. This tool uses 
algorithmic logic to brighten the lighter areas of the image and deepen the darker areas to better 
visually distinguish detected objects in the well. This may make it easier to detect the presence of 
objects if the image has poor contrast without the enhancement, but it may also introduce noise to an 
image that is already of good quality.  

•  [Open] – opens an image file taken with the [Snap] tool. 

•  [Save] – saves an image taken by the [Snap] tool to a file on the computer. The icon is shown 
grayed out here, but will darken to black (meaning it is active and can be interacted with) when a 
snapshot is present in the viewer. 

•  [Zoom In] – zooms in on the image file taken with the [Snap] tool. 

•  [Zoom Out] – zooms out of the image file taken with the [Snap] tool. 

•  [Reset] – resets the image file to the default zoom setting. 

D. Using the Image Viewer 
As mentioned in the overview section, the microscope feature is intended to assist with optimizing the 
imaging settings needed during the cell scan step. In general, you want to adjust the "Exposure" time and 
"Gain" so that all cells are clearly visible above the background, i.e., a high signal-to-noise ratio—but be 
careful to not overexpose the image. Higher gain values produce brighter, but also noisier, images. If the 
exposure time is too high, brighter pixels on the camera may become more visible. Also, longer exposure 
times also mean longer scan times. 

Example: 

If using a novel stain for your cells or nuclei samples, and the CellSelect assessment of candidate wells is 
very low, this might be due to the filter settings. By using the microscope features, you could: 

• Experiment with different color channels, exposure duration, and gain on the same set of 36 wells 
(one Pos area) until one set of parameters seems like the best fit for your experimental needs. 

• You could then move to another Pos set to see if those parameters are effective there as well. 

• For comparison purposes, you could use [Snap] to take screenshots of the two areas and compare 
them 
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• You could also use [Snap] to image the same area with different settings to compare those (for 
example Blue and Red to identify live/dead cells).  
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E. Exit the Microscope View 
The Microscope view can be exited in a few ways: 

• Clicking on the    [Home] icon. 
• Clicking on the back arrow (Figure 83). This will return you to the User Utilities view. 

 
Figure 83. Where to locate the back arrow in the Microscope view. 

• Navigating to a different selection in the Options menu (hamburger  icon). 

• Via timeout after a certain amount of inactivity. 

For all options, when exiting the view, a Move to Teachpoint progress window will pop up (Figure 84). 
This is an expected, routine action indicating the tip nozzle assembly (camera) is returning to 'home' 
(park, 0,0,0) to reset to default. It is recommended to allow the procedure to complete without stopping, 
so the tip nozzle assembly is in a safe position with good access to the dispense platform. 

 
Figure 84. The Move To Teachpoint window displayed when exiting the Microscope view. 
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Appendix A. Designing an Application: Advice from Our Scientists 

A. Overview: Application Workflow 
The graphic below depicts the overall workflow of a typical application performed on the Shasta Single 
Cell System. For additional information on any of the steps, refer to the associated section number. 

 
Figure 85. Application workflow overview. This image is also available in the Shasta Single Cell User Manual. 

  

Initiate or resume an experiment

Prepare sample(s)

Execute a dispense: sample
(and controls, if used)

Scan chip*

Freeze chip (optional†)

Execute a dispense: reagent or index

Run PCR reaction‡

Extract library from chip

Additional off-chip processing
(as needed) and sequencing

Repeat 
dispense and 
PCR reaction 
steps as 
needed for 
each reagent 
and index in 
the application. 

*Only required when 
samples are cells or 
nuclei and if single-
cell or -nuclei 
isolation is desired. 

†Required step for 
cell samples. 

‡When 
required by the 
application. 
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B. How Should I Begin? 
You can think of transitioning to the Shasta system as miniaturization of an existing protocol that has 
already been tested at larger volumes. A protocol that is a good candidate for an application on the Shasta 
system is one in which consecutive reactions are additive (i.e., only addition of reagents, no purification 
required between steps).   

It may be a good idea to perform in-tube experiments to figure out the initial concentrations and volumes 
for each reagent and reaction conditions for each step, then scale down to apply them to the first 
experiment in chip. However, conditions that work in tube do not necessarily work in chip without some 
further optimization. 

C. How Do I Choose What Chip to Use? 
Currently, two Single-Cell chips with volumes of 250 nl (Cat. No. 640183) and 350 nl (Cat. No. 640019), 
are available from Takara Bio for the Shasta system. The recommended target volume per well for 
these chips are 235 nl and 300 nl, respectively. Choose the correct chip according to the total volume 
being dispensed per well. 

As all samples will be extracted and pooled at the end of the application, each well needs to be 
identifiable by dispensing unique barcodes (or combinatorial index pairs) as part of the application.  

D. What Volume Should I Dispense? 
Calculate and choose the right dispense volume according to the number of steps and the concentration 
of reagents and indexes. 

• The predefined volume options for cell, RNA, and DNA dispenses are 35 nl or 50 nl per well. 

• The predefined volume options for reagents and index dispenses are 35 nl, 50 nl, or 100 nl per well. 

We have guidelines for testing the dispense quality of reagents and acceptable concentrations of some 
common buffer components; see the tech note at takarabio.com. In cases where a larger volume of a less 
concentrated component is needed, the dispense volume for cells or other reagents may need to be 
reduced to accommodate the maximum allowable volume in the nanowell. 

The number of steps available for your application depends on the dispense volume of each step and the 
Single-Cell chip type. Table 6 shows the maximum steps allowed for a 250 nl and a 350 nl chip at 
equivalent volumes for each step. 

Table 6. Recommended volume fill of sample, control, reagent, or indexes added to the sample source plate 

Dispense 
volume per step 

250 nl chip 
(Max. vol.: 235 nl) 

350 nl chip 
(Max. vol.: 300 nl) 

35 nl 6 8 

50 nl 4 6 

100 nl 2 3 

The dispense volume for each step can be different. An example is shown in Table 7 (next page). 
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Table 7. Example application workflow for a 350 nl chip with 7 steps and differing dispense volumes in the steps 

  Application workflow 350 nl chip  

Step 1: Cell dispense  35 nl  

Step 2: RT-PCR mix dispense  50 nl  

Step 3: Master mix 1 dispense  50 nl  

Step 4: Master mix 2 dispense 35 nl 

Step 5: Index 1 dispense  35 nl  

Step 6: Index 2 dispense  35 nl  

Step 7: PCR mix dispense  50 nl  

TOTAL: 7 steps 290 nl 

E. What Centrifugation Conditions Should I Use for my Chip? 
Table 8 lists our recommendations for initial centrifuge parameters after a sample, reagent, or index 
dispense into the Single-Cell chip. 

Table 8. Initial recommendations for centrifuge guidelines by dispense type for custom applications. 

Dispense type Centrifuge 
temperature Time Centrifuge 

speed 
Sample 22°C 5 min 300g 
Reagent or index 4˚C 3 min 3,220g 

While developing your custom application, experiment, if needed, to determine the parameters best for 
your conditions. 

F. Tips for Developing a New Protocol for the Shasta System 
• If your application allows it, you should consider using nucleic acids to mimic single cells (or nuclei) 

as your starting material. For example, you could use purified total RNA (at an estimated 2–15 pg of 
total RNA per cell) or genomic DNA (at an estimated 6 pg of genomic DNA per cell). 

• Nucleic acids should be diluted in whatever the cells will be dispensed in (i.e., PBS). We suggest 
confirming that the reagent used to dispense the sample dispenses without issue. 

• We have observed that Second Diluent improves dispense quality of cells, thereby increasing the 
candidate count, and suggest adding Second Diluent 100X to cells, nucleic acids, and all controls. 
During initial application development, test that the addition of Second Diluent will not interfere with 
your reaction, so this recommendation can be implemented. If you cannot use Second Diluent, you 
may see more doublets than expected from a standard Poisson distribution.  

• Recombinant RNase Inhibitor (Takara Bio, Cat. No. 2313A or 2313B) should be included for RNA 
dispenses, and it should also be included with a cell dispense for any application that will use RNA. 

• During the development of an application, you should also monitor your application at various steps. 
For example, if RT-PCR is the first step, you may want to extract the product off the chip after this 
stage to look at the profile on a fragment analyzer (e.g., Agilent2100 Bioanalyzer used with the 
Agilent High Sensitivity DNA Kit (Agilent, Cat. No. 5067-4626), the Fragment Analyzer and High 
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Sensitivity Large Fragment Analysis Kit (Advanced Analytical Technologies, Inc., Cat. No. DNF-
493), or an equivalent microfluidic device/kit to see if it looks as expected. 

• You can also use an intermediate product to mimic being partway through protocol. To continue with 
the example above, if you use RT-PCR upstream, you could dispense cDNA you have generated in-
tube to the chip, and then test downstream steps, like PCR or ligation. 

G. Considerations for Special Types of Cells 
If your cells settle quickly, such as cardiomyocytes, you should consider taking advantage of the 
CELLSTUDIO software "Ask user to remix source plate before aspirating" (pause) option within the 
application workflow configuration. 

Refer to Section III.B.3.b, "Pause Before Aspiration", for how to configure this in the application and 
Shasta Single Cell User Manual, Section IX.E, "Start Dispense", for an example of how the function 
would affect the sample dispense step in the workflow. 

H. Positive and Negative Control Recommendations 
CELLSTUDIO software designates specific wells in the source plate for positive and negative controls. 
At early stages of application development, we recommend including a negative control (PBS or the 
dispense reagent your cells will be in are good choices). Water does not dispense well and is therefore not 
a good negative control. 

Once you move to testing your protocol with cells, we recommend including a positive control in addition 
to the negative control. The purified nucleic acid that you used to develop your application is a good 
choice for a positive control. Positive control wells can be left empty if there is no proper positive control 
for an application. 

I. Indexing 
We recommend combinatorial dual indexing, as CELLSTUDIO software allows for up to 72 forward and 
reverse indexes. Single indexing would require 5,184 unique indexes, each to be dispensed to the correct 
location, which is beyond the capabilities of the software. 

J. Testing Different Conditions 
• When using nucleic acids prior to using cells, you will most likely be dispensing reagents to every 

nanowell of the dispense pattern.  
• For unfiltered dispenses, up to eight different reagent compositions for each reagent can be added to 

their corresponding source wells for reagent dispensing. 
• For filtered dispenses, up to four different reagent compositions for each reagent can be added to their 

corresponding source wells for reagent dispensing. This can be used to simultaneously test more than 
one experimental condition in a chip: different reagents or reagent compositions can be added to their 
corresponding source well for dispensing. 
Example: 
If you wanted to test four different magnesium concentrations in a PCR master mix, and the master 
mix is Reagent 4, then each test concentration can be added to wells M11, N11, O11, and P11 in the 
source well plate. CELLSTUDIO software will track which source well was dispensed to each chip 
nanowell so you can later review the effect of different magnesium concentrations on the results. 

http://www.takarabio.com/
https://www.takarabio.com/resourcedocument/x348670


 Shasta™ Single Cell Advanced Features User Manual 

(072425) 
 

takarabio.com 
Takara Bio USA, Inc. 

Page 64 of 72 

 
 

• If there is more than one reagent source well, CELLSTUDIO software has been designed to dispense 
approximately equal numbers of nanowells from each of the source wells. 

• Different filter files can be manually created (Shasta Single Cell User Manual, Appendix C) to guide 
the instrument to dispense different reagent compositions into specific wells. This approach also 
allows selection of which positive and negative controls receive which reagent composition. Make 
sure to add reagent to the same location of a new source plate for each filter file using the same step. 
Example: 
One magnesium concentration can be used in each of the source wells, but a filter file can be used to 
define exactly which nanowells receive that reagent. Reagent4 would be selected for each of the 
dispenses, but a different filter file selected.  

• After library generation and sequencing, the *_WellList.txt file (Shasta Single Cell User 
Manual, Section XI) should be used as the WellList.txt for input into Cogent NGS Analysis 
Pipeline (CogentAP). 

• After the data is analyzed by CogentAP, you can generate a chip map source well data file 
(Section V.B.3.e, "Export all data/Export heatmap data") to determine which nanowells (identified by 
their barcodes) received which reagent. 

K. Improving Cell Reactivity 
Including molecular biology-grade BSA in the cell dispense may improve cell viability. For RNA-based 
assays, we recommend Recombinant RNase Inhibitor (Takara Bio, Cat. No. 2313A or 2313B).  

Once you move to cells, you will have to be sure that your cells are sufficiently lysed prior to moving to 
the next step. For many cells, a simple freeze/thaw of the chip—freezing at –80°C for at least 30 min—is 
sufficient. 

L. Filtering Dispenses with Nucleic Acid Samples or Samples that are not 
Imaged 
A filter file is automatically generated by CellSelect software after image processing (Shasta Single Cell 
User Manual, Section X and Shasta CellSelect Software User Manual, Section III.D). The filter file is 
commonly used to dispense reagents into the specific wells, although you may also choose not to use one.  

There is no filter file generated after dispensing nucleic acids or in cases where no cell scan (and therefore 
no image processing) is performed. In these situations, if you want to dispense reagents or indexes to only 
a subset of the nanowells, you will need to manually create your own filter file to target specific wells in 
the chip and choose to have those dispense steps require your custom filter file when you set up the 
application. 

For more information about creating or editing to customize an existing filter file, see the Shasta Single 
Cell User Manual, Appendix C.B. 
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M. Cell Labeling Options 
CELLSTUDIO software allows up to three combinations of the three filters (blue, red, and green) for 
taking cell images. Cells may be stained with dyes such as Hoechst and propidium iodide, labeled with 
fluorescent antibodies, or by expression of a fluorescent protein. 

CellSelect software identifies wells containing signal and generates a filter file based on rules the user 
chooses to guide the Shasta instrument to dispense reagents into those wells. For example, you may only 
want cells positive for Hoechst but negative for propidium iodide, but you may use a FITC-labelled CD4 
antibody and an RFP-labeled CD8 antibody, use CellSelect software to identify your cell populations, and 
then select the cells you wish to process. 

See the Shasta Single Cell User Manual, Appendix C.A for more details about the structure of filter files, 
or the Shasta CellSelect Software User Manual (Section III.D and III.I) for more information about how 
the CellSelect software creates the files. 

N. Reagent Parameters 
In general, the Shasta instrument can dispense a wide variety of reagents. Takara Bio has established 
guidelines for common reagent components, including those that are viscous or have low surface tension 
(see the tech note at takarabio.com), and we will continue to expand testing. 

For reagents or combinations not in the tech note, we provide guidelines for testing the dispense quality. 
One simple test is to dispense a reagent and then use blotting paper on the chip. If the blotting paper has a 
large damp area (see Figure 86, below), that could indicate the dispense was not successful. If necessary, 
you may need to make the reagent more or less concentrated and/or dispense a different volume to 
accommodate for the final concentration in the reaction. 

Pure water does not dispense well on the instrument. If you wish to dilute your reactions, we recommend 
dispensing 10 mM Tris or PBS into the chip. Additionally, you can try adding 100X Second Diluent 
(Takara Bio, Cat. No. 640016) or a low percentage of PEG8000 to a reagent that does not pass the blot 
test. 

 
Figure 86. Images from failed dispenses. (Left) Blotting paper shows large damp area. (Right) Chip shows liquid on top of 
chip. 
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O. Maximum Potential Volume of Eluate Extracted from the Chip 
The volume of the eluate collected will be less than the calculated maximum volume (formula below). 
Evaporation, which may occur when the chip is not sealed, decreases the volume. Having more dispense 
steps will increase the chances of evaporation, further decreasing the final volume. 

To calculate the maximum potential volume (in µl) from the chip, use the formula: 

(𝑇𝑇𝑇𝑇𝑇𝑇𝑇𝑇𝑇𝑇 𝑠𝑠𝑇𝑇𝑠𝑠𝑠𝑠𝑇𝑇𝑠𝑠 𝑣𝑣𝑇𝑇𝑇𝑇𝑣𝑣𝑠𝑠𝑠𝑠)  +  (𝑁𝑁𝑣𝑣𝑠𝑠𝑁𝑁𝑠𝑠𝑁𝑁 𝑇𝑇𝑜𝑜 𝑐𝑐𝑇𝑇𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑇𝑇𝑇𝑇𝑠𝑠𝑠𝑠 𝑥𝑥 (𝑊𝑊𝑠𝑠𝑇𝑇𝑇𝑇 𝑐𝑐𝑐𝑐𝑠𝑠𝑠𝑠𝑠𝑠𝑐𝑐𝑠𝑠𝑠𝑠 𝑣𝑣𝑇𝑇𝑇𝑇𝑣𝑣𝑠𝑠𝑠𝑠)) 
1,000 𝑐𝑐𝑇𝑇/µ𝑇𝑇

 

where: 

Total sample volume = Number of wells * x Sample dispense volume per well 

Well dispense volume = Total volume of reagent dispenses per well  + 

Total volume of index dispenses per well 

*Number of wells should include both positive and negative controls in addition to the number of candidate wells. 

Example 

When doing Shasta WGA: 

• The entire chip is used (72 x 72 dispense pattern), so Number of wells = 5,184 

• Sample dispense volume per well is configured as: 50 nl/well 

• There are three reagent dispenses (DNA extraction, preamplification, and amplification) of 
50 nl each 

(50 nl/well + 50 nl/well + 50 nl/well) = 150 nl/well 

• There are two index dispenses (Index1 and Index2) of 50 nl each 

(50 nl/well + 50 nl/well) = 100 nl/well 

If 1,000 nanowells are selected as candidate wells (Number of candidates), the formula would be: 

Maximum potential volume (µl) =  
(5,184 x 50 nl

well) +  (1,000 x (150 nl
well + 100 nl

well)) 
1,000 nl/µl

 

and the maximum potential value would be: 509 µl 
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P. Designing Programs for the Single-Cell Thermal Cycler 
To achieve the temperatures in the Single-Cell chip that are required by your protocol (as determined by 
in-tube reactions), the Single-Cell Thermal Cycler needs to be programmed appropriately. Table 9 is 
provided to aid in the selection of the temperature setpoints. 

• The first column is the desired protocol set point. 
• The second column is the actual set point of the cycler. 

To reach the desired temperature, the thermal cycler must be programmed with a temporary over (or 
under) temperature value for the duration indicated in the table. 

Example: 

If the cycler is currently set at 72°C and you wish to go down to 40°C, the next 2 steps in your protocol 
would be: 

• 34.5°C for 6 sec 

• 39.2°C for the duration required by your protocol. 

If the cycler is at 20°C and you wish to go up to 40°C, the next 2 steps in your protocol would be: 

• 45.2°C for 5 sec 

• 39.2°C for the duration required by your protocol 

NOTES: 
– The initial setpoint and its duration depend on the chip target temperature. 
– Table 9 is only valid if the lid temperature is set to 72°C. 

Table 9. Thermal cycler lookup table. Table continues over the next three pages. 

      
Starting temperature 

lower than target  
 Starting temperature 

higher than target  

Chip 
target (°C) 

Thermal 
cycler set 
point (°C) 

Initial set 
point (°C) 

Duration 
(sec) 

 
Initial 

setpoint (°C) 
Duration 

(sec) 
16  13.3  NA  NA   12.9  8  
17  14.5  NA  NA   13.7  8  
18  15.7  NA  NA   14.6  8  
19  16.8  NA  NA   15.5  8  
20  17.9  NA  NA   16.3  8  
21  19.1  NA  NA   17.2  8  
22  20.2  NA  NA   18.1  8  
23  21.3  NA  NA   19.0  10  
24  22.4  NA  NA   19.8  10  
25  23.5  NA  NA   20.7  10  
26  24.6  NA  NA   21.6  10  
27  25.7  NA  NA   22.5  10  
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Starting temperature 

lower than target  
 Starting temperature 

higher than target  

Chip 
target (°C) 

Thermal 
cycler set 
point (°C) 

Initial set 
point (°C) 

Duration 
(sec) 

 
Initial 

setpoint (°C) 
Duration 

(sec) 
28  26.7  NA  NA   23.4  10  
29  27.8  NA  NA   24.3  10  
30  28.8  NA  NA   25.2  10  
31  29.9  36.6  5   26.2  10  
32  30.9  37.5  5   27.1  10  
33  32.0  38.5  5   28.0  10  
34  33.0  39.4  5   28.9  10  
35  34.1  40.4  5   29.8  6  

36  35.1  41.4  5   30.8  6  

37  36.1  42.3  5   31.7  6  

38  37.2  43.3  5   32.7  6  

39  38.2  44.3  5   33.6  6  

40  39.2  45.2  5   34.5  6  

41  40.2  46.2  5   35.5  6  

42  41.2  47.2  5   36.5  6  

43  42.3  48.1  5   37.4  6  

44  43.3  49.1  5   38.4  6  

45  44.3  50.0  5   39.4  6  
46  45.3  51.0  5   40.3  6  
47  46.3  52.0  5   41.3  6  
48  47.3  52.9  5   42.3  6  
49  48.4  53.9  5   43.3  6  
50  49.4  54.9  5   44.3  6  
51  50.4  55.8  5   45.3  5  
52  51.4  56.8  5   46.2  5  
53  52.4  57.8  5   47.2  5  
54  53.5  58.7  5   48.3  5  
55  54.5  59.7  5   49.3  5  
56  55.5  60.6  5   50.3  5  
57  56.5  61.6  5   51.3  5  
58  57.5  62.6  6   52.3  5  
59  58.6  63.5  6   53.3  5  
60  59.6  64.5  6   54.4  5  
61  60.6  65.5  7   55.4  5  
62  61.7  66.4  7   56.4  5  
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Starting temperature 

lower than target  
 Starting temperature 

higher than target  

Chip 
target (°C) 

Thermal 
cycler set 
point (°C) 

Initial set 
point (°C) 

Duration 
(sec) 

 
Initial 

setpoint (°C) 
Duration 

(sec) 
63  62.7  67.4  7   57.5  5  
64  63.7  68.4  8   58.5  5  
65  64.8  69.3  8   59.6  5  
66  65.8  70.3  8   60.6  5  
67  66.9  71.2  9   61.7  5  
68  67.9  72.2  9   62.7  5  
69  69.0  73.2  9   63.8  5  
70  70.0  74.1  10   64.9  5  
71  71.0  75.1  10   66.0  5  
72  72.1  76.1  10   67.0  5  
73  73.2  77.0  11   68.1  5  
74  74.2  78.0  11   69.2  5  
75  75.3  79.0  11   70.3  5  
76  76.3  79.9  12   71.4  5  
77  77.4  80.9  12   72.5  5  
78  78.4  81.8  12   73.6  5  
79  79.5  82.8  12   74.7  5  
80  80.6  83.8  13   75.8  5  
81  81.6  84.7  13   76.9  5  
82  82.7  85.7  13   78.0  5  
83  83.8  86.7  14   79.1  5  
84  84.8  87.6  14   80.3  5  
85  85.9  88.6  14   81.4  5  
86  86.9  89.6  15   82.5  5  
87  88.0  90.5  15   83.7  5  
88  89.1  91.5  15   84.8  5  
89  90.1  92.4  16   NA  NA  
90  91.2  93.4  16   NA  NA  
91  92.2  94.4  16   NA  NA  
92  93.3  95.3  17   NA  NA  
93  94.4  96.3  17   NA  NA  
94  95.4  97.3  17   NA  NA  
95  96.5  98.2  18   NA  NA  
96  97.5  99.2  18   NA  NA  
97  98.5  100.0  18   NA  NA  
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Starting temperature 

lower than target  
 Starting temperature 

higher than target  

Chip 
target (°C) 

Thermal 
cycler set 
point (°C) 

Initial set 
point (°C) 

Duration 
(sec) 

 
Initial 

setpoint (°C) 
Duration 

(sec) 
98  99.6  100.0  18   NA  NA  
99  100.0  100.0  18   NA  NA  

100  100.0  100.0  18   NA  NA  

Appendix B. Creating an Offline Instructions PDF 
The offline instructions file can be a PDF in any format. However, for your convenience, a template file in 
Microsoft Word DOTX format can be downloaded from takarabio.com; this template is identical to what was 
used to generate the offline instruction files for the Takara Bio prevalidated applications. 

 
Figure 87. Offline instructions template file snapshot. 

The text in the body of the document and embedded comments provide guidelines for how to synthesize a new 
instructions document following the same style. 

Procedure 

To generate an offline instructions file, using either the template provided or your own format: 

1. Create a file of a type that can be converted to a PDF. 

• Examples of this include MS-Word, Excel, PowerPoint, Rich Text Format, TXT, etc. 
• The file can have any name valid for Windows. 
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NOTE: The file name will be visible when the offline instructions display in the workflow, so it is 
recommended to give the file a meaningful or at minimum a work-safe name. 

 
Figure 88. Offline instruction file name, shown on the Instruction view after a dispense. The file name is outlined by the red 
box. 

• If using the template (DOTX) file, download it from the website and open it. This will create a new 
DOCX file without affecting the original file downloaded. Save the new file with your preferred file name 
somewhere on your computer where you can easily find it later. 

2. In your file, write up the directions for users of your custom application. 

While writing the instructions, keep in mind that they will display AFTER the dispense step it will be 
associated with, e.g., to blot, seal, centrifuge, and freeze the chip after imaging cells. This is an opportunity to 
communicate any steps in the process you want a user to take prior to the next dispense step. 

• If you used the downloaded DOTX file as a starting point, before saving the finalized instructions, go into 
the Review>Comments>Delete dropdown menu and select Delete All Comments in Document. This is 
recommended so the PDF file created does not contain information unnecessary to executing the 
instructions you're providing. 

 
Figure 89. How to delete all comments from an instruction file created from the template. 

3. Save the file and convert to a PDF. For more information on how to convert your file to a PDF, please 
reference the instructions for your original file type. 

• If using the template file in MS-Word, generate the PDF by going into the File>Save As menu option and 
selecting PDF as the file type from the dropdown box (Figure 90, next page). 
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Figure 90. How to save an offline instruction file written in MS-Word as a PDF. 

4. Use the resulting PDF file as input when defining the offline instruction for the associated dispense step 
(Section III.B.5, "Offline Instructions PDF File"). 
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